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SIMIT Process Simulation – Basics of 

simulation creation 

 

1 Goal 

The following pages will show how a simple simulation for a sorting station with conveyor and 

extension cylinder can be created in the SIMIT process simulation software. 

 

 

2 Requirement 

This chapter builds on the chapter SIMIT Process Simulation – Coupling with S7-PLCSIM 

Advanced via TCP/IP. You can use the following project for this chapter, for example: "sce-020-

110 simit-s7-1500 plcsimadv-ie-en.simarc". 
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3 Required hardware and software 

1 Engineering station: Requirements include hardware and Windows 10 operating system 

(for additional information, see Readme on the TIA Portal Installation DVDs) 

2 SIMATIC STEP 7 Professional software in TIA Portal – V15.1 or higher 

3 SIMATIC S7-PLCSIM Advanced software – V2.0 SP1 or higher 

4 SIMIT software – V10.0 Update 1 or higher (with dongle or in demo mode) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 Engineering station 

 

2 SIMATIC STEP 7 

Professional (TIA 

Portal) – V15.1 or 

higher 

 

4 SIMIT – V10.0 

Update 1 or higher 

 

3 SIMATIC S7-PLCSIM 

Advanced – V2.0 SP1 

or higher 
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4 Theory 

4.1 SIMIT V10 

SIMIT is process simulation software that can be used for the following: 

– Complete plant simulation 

– Simulation of signals, devices and plant responses 

– Input and output simulator of test signals for an automation controller 

– Testing and commissioning of automation software 

 

SIMIT provides the following components for creating a simulation: 

- Chart 

To build a simulation, components available in the libraries are put together in the chart editor 

and suitable parameters are entered.  

- Visualization 

Visualizations provide an overview of the signals of your plant. Signals are visualized with 

controls (input and display objects) and graphic objects. 

- Coupling 

The coupling is the interface to the automation system and is required for signal exchange. In 

addition to couplings with PLCSIM, PLCSIM Advanced, PRODAVE, etc., there is also a coupling 

with SIMIT as OPC UA client. 

 

Demo mode 

Demo mode provides you with an idea of the handling and performance of SIMIT without having 

a valid license. 

However, SIMIT has only a limited range of functions in demo mode. 

Existing models can be opened and simulated in demo mode. These models can also be 

modified, and new models can also be created. The models created or modified in demo mode 

can only be executed on the computer on which they were created. 

SIMIT Simulation is limited to 45 minutes in demo mode. The simulation must then be restarted.  

  



Learn-/Training Document | TIA Portal Module 020-100, Edition 05/2019 | Digital Industries, FA  

For unrestricted use in educational / R&D institutions. © Siemens 2019. All rights reserved. 7   

sce-020-120 simit-basics-r1909-en.docx 

Note: 

− Additional details and information can be found in the manuals, which can be downloaded 

from support.automation.siemens.com. 

 

5 Task 

A simulation for a sorting station with conveyor and extension cylinder is to be created in a SIMIT 

project with existing coupling with PLCSIM Advanced via TCP/IP.  

The symbols for the inputs and outputs are already created for the coupling. 

5.1 Short description of the sorting station 

The automated sorting station (see Figure 1) is used to separate plastic and metal parts. A part is 

fed to the conveyor via a chute. The conveyor starts as soon as the part has been detected. If a 

part made of metal is on the conveyor, it is detected, transported up to the height of the metal 

magazine and pushed by a cylinder into the metal magazine. If no metal is detected, the part is 

made of plastic. The plastic part is transported to the end of the belt, where it falls into the plastic 

magazine. As soon as a part is sorted, the next part can be fed. 

5.2 Technology diagram 

 

Figure 1: Technology diagram 

 

Figure 2: Control panel 

http://support.automation.siemens.com/
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5.3 Reference list of the sorting station 

 

DI Type Identifier Function NC/NO 

I 0.0 BOOL -A1 Return signal emergency stop OK NC 

I 0.1 BOOL -K0 Main switch "ON" NO 

I 0.2 BOOL -S0 Mode selector manual (0)/ automatic (1) 
Manual = 0 
Auto = 1 

I 0.3 BOOL -S1 Pushbutton automatic start NO 

I 0.4 BOOL -S2 Pushbutton automatic stop NC 

I 0.5 BOOL -B1 Sensor cylinder -M4 retracted NO 

I 0.6 BOOL -B2 Sensor cylinder -M4 extended NC 

I 0.7 BOOL -B3 
Sensor motor -M1 active (pulse signal also 
suitable for positioning) 

NO 

I 1.0 BOOL -B4 Sensor part at chute NO 

I 1.1 BOOL -B5 Sensor metal part detection NO 

I 1.2 BOOL -B6 Sensor part in front of cylinder -M4 NO 

I 1.3 BOOL -B7 Sensor part at end of conveyor NO 

I 1.4 BOOL -S3 
Pushbutton manual mode conveyor –M1 
forwards 

NO 

I 1.5 BOOL -S4 
Pushbutton manual mode conveyor –M1 
backwards 

NO 

I 1.6 BOOL -S5 
Pushbutton retract cylinder -M4, "manual 
mode" 

NO 

I 1.7 BOOL -S6 
Pushbutton extend cylinder -M4, "manual 
mode" 

NO 
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DO Type Identifier Function  

Q 0.0 BOOL -Q1 Conveyor motor -M1 forwards fixed speed  

Q 0.1 BOOL -Q2 Conveyor motor -M1 backwards fixed 
speed 

 

Q 0.2 BOOL -Q3 Conveyor motor -M1 variable speed  

Q 0.3 BOOL -M2 Cylinder -M4 retract  

Q 0.4 BOOL -M3 Cylinder -M4 extend  

Q 0.5 BOOL -P1 Display "main switch on"  

Q 0.6 BOOL -P2 Display "manual mode"  

Q 0.7 BOOL -P3 Display "automatic mode"  

Q 1.0 BOOL -P4 Display "emergency stop activated"  

Q 1.1 BOOL -P5 Display "automatic mode started"  

Q 1.2 BOOL -P6 Display cylinder -M4 "retracted"  

Q 1.3 BOOL -P7 Display cylinder -M4 "extended"  

AI Type Identifier Function  

IW 64 INT -B8 Sensor actual value speed of motor +/-10V  

IW 66 INT -B9 
Setpoint specification via potentiometer +/- 
10V 

 

     
AO Type Identifier Function  

QW 64 INT -U1 
Manipulated value speed of motor in 2 
directions +/- 10V 

 

 

Legend for reference list 

DI Digital input DO Digital output 

AI Analog input AO Analog output 

I Input Q Output 

NC Normally Closed (contact)   

NO Normally Open (contact)   
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6 Planning 

First, the existing SIMIT project is retrieved from the archive in order to then create the simulation 

of the sorting station. 

The simulation is subdivided into the following charts: 

– Control display with conveyor 

– Conveyor motor 

– Part 

– Light barrier 

– Metal sensor (exercise) 

– Cylinder (exercise) 

 

For testing the simulation, the simulation will be started in the SIMIT project. PLCSIM Advanced 

is then also activated in the background, and the TIA Portal project can be loaded into PLCSIM 

Advanced for testing. 
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7 Structured step-by-step instructions 

You can find instructions on how to carry out planning below. If you already have a good 

understanding of everything, it will be sufficient to focus on the numbered steps. Otherwise, 

follow the individual instructions in the steps below. 

7.1 Retrieving an existing project in SIMIT 

→ Start SIMIT from the desktop of your computer by double-clicking on the logo for the "SIMIT 

SP" application (for Demo mode, "SIMIT SP Demo"). ( → SIMIT SP) 

 

→ Retrieve the project "sce-020-110 simit-s7-1500 plcsimadv-ie-en.simarc".  

( → Retrieve project → sce-020-110 simit-s7-1500 plcsimadv-ie-en.simarc → Retrieve) 
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→ Confirm the security prompt with "Yes". ( → Yes) 

 

 

→ Change to the "Project view". ( → Project view) 
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→ Save your project under the name "020-120_sorting_station_PLCSIMAdv_IE".  

(→ Project → Save as … → 020-120_sorting_station_PLCSIMAdv_IE → Save) 
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7.2 Creating the "01_control_display" chart and the display of the 

simulated sorting station 

→ Now, create a "New chart" in your project "020-120_sorting_station_PLCSIMAdv_IE". ( → 

Project → 020-120_sorting_station_PLCSIMAdv_IE → Charts → New chart) 

 

 

→ The new chart is opened. Change the "Name" to "01_control_display" in the "Properties" 

under "General". ( → Properties → General → Name: 01_control_display) 
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→ Next, change the format of "01_control_display" by entering the value 1050 for "Width" and 

the value 565 for "Height". Then, click "Background image " to open an input dialog for 

selecting the graphic. ( → Width: 1050 → Height: 565 → Background image  ) 

 

Note: 

− The project should be saved and compiled at regular intervals by clicking  "Save all". If the 

last changes in the open chart have not yet been saved and compiled, the symbol * is 

displayed behind the name of the chart. 
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→ Now, select the "Foerderband_Conveyor.bmp" image from the "sce-020-120-graphics-en" 

folder and accept it as the background image by clicking "Open". ( → sce-020-120-graphics-

en → Foerderband_Conveyor.bmp → Open) 

 

 

→ You will find graphic elements for use in the charts in the "Graphic" task card on the right. 

First, you want to draw a circle for displaying the plastic parts. Press and hold down the "Ctrl" 

key and select an "Ellipsis" from "Graphic tools" and draw a circle on the left end of the 

conveyor, as shown here. ( → Graphic → Graphic tools → Ctrl → Ellipsis) 
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→ Change the "Name" to "plastic_part" in the "Properties" under "General".  

( → Properties → General → Name: plastic_part) 

 

 

→ Under "Appearance" in the "Properties", change the "Fill color" to orange.  

( → Properties → Appearance → Fill color: orange) 
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7.3 Creating the "02_conveyor_motor" chart with simulation logic 

→ Create another chart named "02_conveyor_motor" with the format shown here. ( → New 

chart → Name: 02_conveyor_motor → Width: 800 → Height: 700) 

 

→ You will find the component types of the basic library under "Basic components" on the right 

in the "Components" task card. For simple simulation of the conveyor motor, drag an → 

"AND", located under → "Standard" → "BinaryBasic", to the "02_conveyor_motor" chart. ( → 

Components → Basic components → Standard → BinaryBasic → AND) 
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→ The "AND" has two inputs by default. Further inputs are available when you zoom in on the 

component.  

 

Note: 

− The number of inputs can be set to a value between 2 and 32. All inputs are preset with 1. 

 

→ Change the "Name" to "Conveyor_forwards" in the "Properties" under "General“ and select 

the "Show names" check box " ".  ( → Properties → General → Name: Conveyor_forwards 

→ Show names  ) 
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→ First, the input of the "Conveyor_forwards" component is to be connected to an output signal 

of the PLC. Drag the → "Output" component, located under → "CONNECTORS", to the 

"02_conveyor_motor" chart in front of the "AND". ( → Components → Basic components → 

CONNECTORS → Output)  

 

→ In the "Signals" task card, you can search for the signals in the open project and have them 

displayed. Open → "Properties" → "General" of the "Output" component. Drag the → "-Q1" 

signal there to "Signal". ( → Properties → General → Signals → -Q1 → Signal ) 
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→ Now, establish the connection of the "Output" component with the "-Q1" signal from the PLC 

to the "AND" component ("Conveyor_forwards"). This happens by first clicking the input 

symbol at the top →  of the "AND" component ("Conveyor_forwards") and then clicking the 

output symbol →  of "Output" (-Q1). The connection is automatically closed.  

( →  Conveyor_forwards → -Q1 ) 

 

7.4 Creating the "03_part" chart with simulation logic 

→ Create another chart named "03_part" with the format shown here. ( → New chart → Name: 

03_part → Width: 800 → Height: 700) 
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→ The → "Ramp" component from the "Basic components" under → "STANDARD" → 

"AnalogExtended" is suitable for simulating the position of the part in the X-axis direction. 

Drag this component to the "03_part" chart. Change the "Name" to "Position_part_X" in the 

"Properties" under "General" and select the "Show names" check box " ". (→ Components 

→ Basic components → STANDARD → AnalogExtended → Ramp → Properties → General 

→ Name: Position_part_X → Shown names  ) 

 

Note: 

− Additional information on the "Ramp" component is available in the online help and the 

manual. 
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→ To configure a connection between two charts, the → "Connector" component from the 

"Basic components" under → "CONNECTORS" can be used. 

Drag a "Connector" to the "03_part" chart in front of the "Ramp" component 

("Position_part_X") and change the "Name" to "Connector#conveyor_forwards" in the 

"Properties" under "General". Establish a connection of the "Ramp" component 

("Position_part_X") to the "Connector#conveyor_forwards".  

The connection to an input turns the connector into an input connector.  

(→ Components → Basic components → CONNECTORS → Connector → Properties → 

General → Name: Connector#conveyor_forwards →  Position_part_X → 

Connector#conveyor_forwards ) 

 

Note: 

− Additional information on the "Connector" component is available in the online help and the 

manual. 
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→ Also drag a "Connector" to the "02_conveyor_motor" chart behind the "AND" component 

("Conveyor_forwards") and change the "Name" to "Connector#conveyor_forwards" in the 

"Properties" under "General". Establish a connection of the "AND" component 

("Conveyor_forwards") to the "Connector#conveyor_forwards". The connection to an output 

turns the connector into an output connector. By assigning it the identical name, the 

connection to the previously created input connector in the "03_part" chart is made 

automatically. (→ Components → Basic components → CONNECTORS → Connector → 

Properties → General → Name: Connector#conveyor_forwards →   Connector#conveyor_ 

forwards → Conveyor_forwards ) 
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→ Now drag the → "SR_FF" component from the "Basic components" under → "STANDARD" 

→ "BinaryExtended" to the "03_part" chart below the "Ramp" component ("Position_part_X"). 

The purpose of the SR_FF state display is to indicate whether a plastic part is present. 

Change the "Name" to "SR_FF#plastic_part" in the "Properties" under "General" and select 

the "Show names" check box " ". Now, save the project by clicking  "Save all". (→ 

Components → Basic components → STANDARD → BinaryExtended → SR_FF → 

Properties → General → Name: SR_FF#plastic_part → Show names  → ) 

 

Note: 

− Additional information on the "SR_FF" component is available in the online help and the 

manual. 
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7.5 Creating animations in the "01_control_display" chart with 

reference to the simulation logic 

→ In order to now animate the display of the plastic part, select it in the "01_control_display" 

chart. Select the "New animation" item in the "Properties" under "General". (→ plastic part → 

Properties → Animation → Neue animation) 

 

 

→ Select the animation type "Visibility". ( → Visibility → OK) 
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→ "Visibility" now appears as an additional item under Animation. Here, drag the → "Q" signal 

of the "SR_FF#plastic_part" source from the "Signals" task card to the "Signal" property. ( → 

Signals → SR_FF#plastic_part → Q → Signal ) 

 

Note: 

− The "SR_FF#plastic_part.Q" signal only becomes visible in the "01_control_display" chart 

when the "03_part" chart containing the "SR_FF#plastic_part" source has been saved. 
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→ In order to now animate the movement of the plastic part, click on "New animation" again. 

Select the animation type "Movement". (→ plastic part → Properties → Animation → Neue 

animation → Movement → OK) 

 

→ "Movement" now appears as an additional item under Animation. In the "01_control_display" 

chart, you can now specify the destination position with a mouse-click. This position should 

be directly after the end of the conveyor. Alternatively, the coordinates of the destination 

position can be entered. ( → X: 630.0 → Y: 0.0) 
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→ The movement must then still be linked with the output signal of the "Ramp" component 

("Position_part_X"). Here, drag the → "Y" signal of the "Position_part_X" source from the 

"Signals" task card to the "Signal" property. ( → Signals → Position_part_X → Y → Signal ) 
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→ For a part to be placed on the conveyor, drag a "Pushbutton" into the "01_control_display" 

chart, as shown here. You will find operator controls such as "Pushbutton" in the → 

"Controls" under → "Input". Change the "Name" to "generate_plastic_part" in the "Properties" 

under "General",and select the "Show names" check box " ". (→ Controls → Input  → 

Pushbutton → Properties → General → Name: generate_plastic_part → Show names  ) 

 

Note: 

− Additional information on the "Pushbutton" component is available in the online help and the 

manual. 
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→ You link the "generate_plastic_part" pushbutton with the "SR_FF#plastic_part" component in 

the "03_part" chart. Select the "Input" "S1" in the "Properties" of "SR_FF#plastic_part" and 

make it invisible by clicking on " ". Then, select the interconnection option " " for 

"Value/Signal" and drag the → "Y" signal of the "generate_plastic_part" source from the 

"Signals" task card to here. ( → 03_part → SR_FF#plastic_part → Properties → Input → S1 

→  →  → Signals → generate_plastic_part → Y → Value/Signal ) 

 

Note: 

− A link to an input of a component can only be made after the input has been made invisible 

by clicking on " ". 
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→ Now make the local interconnections shown here in the "03_plastic_part" chart. Then click 

"Save all" . ( →  "Save all") 
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7.6 Testing the SIMIT application within SIMIT  

→ Select " " to start the simulation. ( → ) 

 

 

Note: 

− When the simulation is started, PLCSIM Advanced is also automatically activated in the 

background. This allows you to test the access to the inputs and outputs of the S7-1500 

station in SIMIT. Clicking on " " stops the simulation in SIMIT again.  

( → ) 
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→ The simulation is now activated. The application turns orange to indicate this. To set the "-

Q1" output within SIMIT, open the "PLCSIM Advanced" coupling by clicking the station 

contained in it. ( → Couplings → PLCSIM Advanced → S71500-ET200MP station_1) 

 

→ Split the window vertically so that you can see the "01_control_display" chart and the 

coupling at the same time. Now, open the "Outputs" within the PLCSIM Advanced coupling. 

(→ Window → Split vertically → Outputs) 
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→ In order to directly control the "-Q1" output in SIMIT, you must enable the output for 

controlling by clicking on " ". You can then switch "-Q1" on and off with the " " button. ( 

→ Outputs → -Q1 →  → ) 

 

→ The application can now be tested. A part is placed on the starting end of the conveyor by 

clicking on  "generate_plastic_part". If conveyor motor –M1 is switched on with "-Q1" 

(forwards), the part moves to the right at constant speed and disappears again after exiting 

the conveyor. By clicking on " ", the simulation in SIMIT can be stopped again. But, don't 

stop the simulation yet. Rather, leave it running for the next test with the PLC program. 

 

Note: 

− When the simulation in SIMIT is stopped, the instance in PLCSIM Advance is also deleted. 

This means that it is no longer possible to work "online" from the TIA Portal. 
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7.7 Testing the SIMIT application with PLC program  

→ Now, start the "TIA Portal" from the desktop of your computer by double-clicking on the logo 

for the application. (→ TIA Portal) 

 

 

→ Change to the Project view and retrieve the desired TIA Portal project there. The first test 

project for the sorting station project "S020-120-sorting_station_plcsimadv-ie-test01…" is 

retrieved and opened here. (→ Project view → Project → Retrieve → select a *.zap15_1 

archive → 020-120_sorting_station_plcsimadv-ie-test01…zap15_1 → Open) 

 

 

→ The next step is to select the destination folder where the retrieved project will be stored. 

Confirm your selection with "OK".  (→ Target directory → OK) 
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→ To download your entire CPU, select the → "CPU_1516F [CPU1516F-3 PN/DP]" folder and 

click the symbol → "Download to device" .  

 

→ The manager for configuring the connection properties (extended download) opens shortly 

thereafter. 
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→ First, the interface must be correctly selected. This happens in three steps. 

→ Type of the PG/PC interface → PN/IE 

 

 

→ PG/PC interface → PLCSIM (if PLCSIM Advanced has already been started, this is 

preset.) 

 

→ Connection to interface/subnet → "PN/IE_1" 
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→ The search for target devices must then be started by clicking the →  button. 
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→ If the controller is shown in the list, it must be selected before the download can be started. 

(→ CPU1516F → Load) 
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→ You first obtain a preview. Confirm the suggested actions and continue with → "Load". 

 

Note: 

− The  symbol should be visible in every line of the "Load preview". You can find additional 

information in the "Message" column. 

→ The → "Start module" option is now selected before the download operation can be 

completed with → "Finish". 
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→ In order to monitor the interfaces of the called blocks, first open the Main[OB1] block.  

(→ Main [OB1]) 

 

→ The signals interconnected here can now be monitored by clicking the " " button for 

Monitoring on/off. (→ ) 
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→ Now, change to the still activated SIMIT simulation. Here, the "Inputs" of the simulation can 

be displayed under "S71500-ET200MP station_1 (PLCSIM Advanced)" and switched on and 

off by clicking the " " buttons. To switch on the conveyor motor in our program example, 

the inputs should be switched on in the following order: → -A1 → -KO → -S0 → -S2 → -S1.  

(→ S71500-ET200MP station_1 (PLCSIM Advanced)→ Inputs → -A1 → -KO → -S0 → -S2 

→ -S1) 
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→ The changes of the signal states in the Main[OB1] block can be monitored in the TIA Portal.  
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→ The application can now be tested in SIMIT. The conveyor motor –M1 is already switched on 

with "-Q1" (forwards). Clicking on  "generate_plastic_part" places a part on the starting 

end of the conveyor, which then moves to the right at constant speed. The part disappears 

after exiting the conveyor. By clicking on " ", the simulation in SIMIT can be stopped again.  

 

 

Note: 

− When the simulation in SIMIT is stopped, the instance in PLCSIM Advance is also deleted. 

This means that it is no longer possible to work "online" from the TIA Portal. 
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7.8 Creating the "04_light_barrier" chart with simulation logic 

→ Create another chart named "04_light_barrier" with the format shown here. ( → New chart → 

Name: 04_light_barrier → Width: 800 → Height: 700) 
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→ You will find the component types of the basic library under "Basic components" on the right 

in the "Components" task card. For simulation of a light barrier, drag an → "Interval", located 

under → "Standard" → "AnalogExtended", to the "04_light_barrier" chart. Change the 

"Name" to "Interval –B4" in the "Properties" under "General“ and select the "Show names" 

check box " ". (→ Components → Basic components → Standard → AnalogExtended → 

Interval → Properties → General → Name: Interval –B4 → Show names ) 
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→ Select the "Input" "X" in the "Properties" of "Interval -B4" and make it invisible by clicking on "

". Then, select the interconnection option " " for "Value/Signal" and drag the → "Y" 

signal of the "position_part_X" source from the "Signals" task card to here. Then, enter the 

values "3.0" for the "UL" input (high limit) and "0.0" for "LL" (low limit). ( → Properties → Input  

→ X →  →  → Signals → position_part_X → Y → Value/Signal → UL: 3.0 → LL: .0) 
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→ Now, press and hold down the "Shift" key and drag the → "-B4" signal from the "Signals" task 

card to the "04_light_barrier" chart. A "CONNECTOR" of type "Output" is automatically 

created with the "-B4" signal. Deselect the "Show coupling name" check box in the 

"Properties" area under "General". ( → Properties → General → Signals → Shift → -B4 → 

Properties → General → Show coupling name ) 
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→ Then, drag an → "AND" between the "Interval -B4" and "-B4" components from the 

"Components" task card under → "Basic components" → "Standard" → "BinaryBasic".  

( → Components → Basic components → Standard → BinaryBasic → AND) 
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→ Select the "Input" "IN2" in the "Properties" of the "AND" block and make it invisible by clicking 

on " ". Then, select the interconnection option " " for "Value/Signal" and drag the → 

"Q" signal of the "SR_FF#plastic_part" source from the "Signals" task card to here. 

Interconnect the other connectors of the "AND" block, as shown here. ( → AND → Properties 

→ Input  → IN2 →  →  → Signals → SR_FF#plastic_part → Q → Value/Signal ) 
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→ For labeling the light barrier, drag a text from → "Graphic" → "Graphic tools" to the 

"04_light_barrier" chart and enter "-B4 part at starting end of conveyor" as text. (→ Graphic 

→ Graphic tools → Text: -B4 part at starting end of conveyor) 
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→ To display the signal state of the "-B4" sensor in the "01_control_display" chart, drag a 

"Binary display" to the starting end of the conveyor from → "Controls" under → "Display". 

(→ 01_control_display → Controls → Display → Binary display ) 

 

 

Note: 

− Additional information on the "Binary display" component is available in the online help and 

the manual. 
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→ The "Binary display" must now be linked with the "-B4" input signal. Here, drag the → "-B4" 

signal of the "S71500-ET200MP station_1" source from the → "Signals" task card to the → 

"Connector" property. ( → Binary display#1 → Properties → Connector → Signals → 

S71500-ET200MP station_1 → -B4 → Signal ) 

 

→ Change the "Name" to "-B4" in the "Properties" under "General" and select the "Show 

names" check box " ". ( → Property → General → Name: -B4 → Show names ) 
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→ Change "Color (on)" to green in the "Properties" of the "-B4" component under "View". (→ -

B4 → Properties → View → Color (on) ) 

 

→ Now, first save and compile the project by clicking  "Save all" and then start the simulation 

by clicking on " ". (→  → ) 
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→ The application can now be tested in SIMIT by placing a part on the starting end of the 

conveyor by clicking on  "generate_plastic_part". The color of the sensor changes to 

green. The color of the sensor changes back to gray when the part has been moved far 

enough to the right with the conveyor. By clicking on " ", the simulation in SIMIT can be 

stopped again.  
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→ In the "04_light_barrier" chart, as shown previously, create the simulation logic for the 

sensors "-B6" (part in front of cylinder) and "-B7" (part at end of conveyor) with the high and 

low limits. Insert two additional "Binary displays" for these sensors in the "01_control_display" 

chart and test the simulation. 
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7.9 Creating simulation logic for switches and pushbuttons in the 

"01_control_display" chart 

→ For the control panel, first drag a "Rectangle" from → "Graphic" → "Graphic tools" to the 

"01_control_display" chart and change the fill color to a light orange. 

(→ 01_control_display → Graphic → Graphic tools → Rectangle → Properties → 

Appearance → Fill color:  ) 

 

→ For the label, drag a Text from → "Graphic" → "Graphic tools" onto the rectangle, enter 

"Switches Sorting Station" as text and select the same "Fill color" as the rectangle. (→ 

Graphic → Graphic tools → Text: Switches Sorting Station→ Properties → Appearance → 

Fill color: ) 
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→ As the first control element, configure "-K0" (main switch) as "Switch". 

You will find the "Switch" and "Pushbutton" in the → "Controls" under → "Input". 

Change the "Name" to "-K0 main_switch" in the "Properties" under "General", select the 

"Show names" check box " " and leave the "Type" as "Normally open contact".  

(→ Controls → Input → Switch → Properties → General → Name: - K0 main_switch → Show 

names  → Type: Normally open contact) 

 

Note: 

− Additional information on the "Switch" and "Pushbutton" component is available in the online 

help and the manual. 
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→ The "Switch" must now be linked with the "-K0" input signal. Here, drag the → "-K0" signal of 

the "S71500-ET200MP station_1" source from the "Signals" task card to the → "Connector" 

→ "Signal" property. ( → -K0 main_switch → Properties → Connector → Signals → S71500-

ET200MP station_1 → -K0 → Signal ) 

 

→ In the next step, as shown previously, insert an additional "Rectangle" with "Text", the 

switches "-A1" (emergency_stop) and "-S0" (mode_selector) and the pushbuttons "-S1" 

(start) and "-S2" (stop). For the switch "-A1" (emergency_stop) and pushbutton "-S2" (stop), 

change the "type" to "Normally closed contact". (→ -A1 emergency_stop →Properties → 

General → Type: Normally closed contact→ -S2 stop → Properties → General → Type: 

Normally closed contact) 
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→ Change to the "S71500-ET200MP station_1" coupling and select the "Default" check box " " 

for the "-A1" and "-S2" inputs. As a result of this, the signal states of the normally closed 

contacts will already be set to 1 when the simulation is started. 

(→S71500-ET200MP station_1 → Inputs → -A1 → Default → -S2 → Default ) 

 

→ Then, configure the "-P1 ON" display as a binary display. 

You will find the "Binary display" in the → "Controls" under → "Display". Change the "Name" 

to "-P1 ON" in the "Properties" under "General" and select the "Show names" check box " ". 

(→ Controls → Display → Binary display → Properties → General → Name: -P1 ON → Show 

names  ) 
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→ The "Binary display" must now be linked with the "-P1" output signal. Here, drag the → "-P1" 

signal of the "S71500-ET200MP station_1" source from the "Signals" task card to the → 

"Connector" → "Signal" property. ( → -P1 ON → Properties → Connector → Signals → 

S71500-ET200MP station_1 → -P1 → Signal ) 

 

→ In the properties of "P1 ON", change "Color (on)" to blue and "Shape" to "Round". (→ -P1 ON 

→ Properties → View → Color (on)  → Shape Round) 
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→ As shown previously, now create the "Binary displays" "-P4 display 

emergency_stop_activated", "P2 manual", "-P3 automatic" and "-P5 

automatic_mode_started". An additional "Binary display" is also configured for the conveyor 

motor. Connect its "Connector" to the "Signal" "Conveyor_forwards" "OUT" and set "Color 

(on)" to green and "Shape" to "Round". (→ -P4 display emergency_stop_activated → -P2 

manual → -P3 automatic → -P5 automatic_mode_started → Binary display#1 → Properties 

→ Connector → Signals → Conveyor_forwards → OUT → Signal→ View → Color (on)  

→ Shape Round) 

 

→ For the label, drag a Text from → "Graphic" → "Graphic tools" onto the binary display, enter 

"M1" as text and select "No color" as the "Fill color". (→ Graphic → Graphic tools → Text: M1 

→ Properties → Appearance → Fill color: No color) 
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→ Now, save and compile the project by clicking  "Save all" and then start the simulation by 

clicking on " ". Test all functions of the simulation. Clicking on " " stops the simulation in 

SIMIT again. (→  →  → ) 
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7.10 Archiving the project 

→ As the final step, we want to archive the complete SIMIT project. Select the → "Archive …" 

command in the → "Project" menu. Select a folder where you want to archive your project 

and save it as file type "SIMIT project (*.simarc)". (→ Project → Archive → *.simarc) 
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7.11 Checklist – step-by-step instructions 

The following checklist helps trainees/students to independently check whether all steps of the 

step-by-step instructions have been carefully completed and enables them to successfully 

complete the module on their own. 

No. Description Checked 

1 
"01_control_display" chart created in SIMIT according to the 

specification. 

 

2 
"02_conveyor_motor" chart created in SIMIT according to the 

specification. 

 

3 
Animations in the "01_control_display" chart created according to 

the specification. 

 

4 SIMIT project successfully compiled and started. 
 

5 Simulation successfully tested within SIMIT. 
 

6 Simulation successfully tested together with SIMIT Simulation. 
 

7 
"04_light_barrier" chart created in SIMIT according to the 

specification. 

 

8 
Display of sensors added in the "01_control_display" chart 

according to the specification. 

 

9 

Control panel with simulation for switches, pushbuttons and 

displays added in the "01_control_display" chart according to the 

specification. 

 

10 SIMIT project successfully compiled and started. 
 

11 Simulation successfully tested within SIMIT. 
 

12 Simulation successfully tested together with SIMIT Simulation. 
 

13 SIMIT project successfully archived. 
 

 

 

 



Learn-/Training Document | TIA Portal Module 020-100, Edition 05/2019 | Digital Industries, FA  

For unrestricted use in educational / R&D institutions. © Siemens 2019. All rights reserved. 67   

sce-020-120 simit-basics-r1909-en.docx 

8 Exercises 

8.1 Task – Exercise Metal part 

Create the simulation logic for an additional part made of metal in the "03_part" chart. 

Create a new "05_metal sensor" chart for "-B5" (Sensor metal part) and display the "-B5" sensor 

and the animated metal part in the "01_control_display" chart. 

Add a "Pushbutton" in the "01_control_display" chart for placing a metal part on the conveyor. 

Interlock the simulation logic in such a way that only one part at a time can be on the conveyor.  

 

 

Figure 3: Control display with metal part 

 

8.2 Planning 

Plan the implementation of the task on your own.  

For testing you can load the following TIA Portal project in S7-PLCSIM Advanced:  

"020-120-sorting_station_plcsimadv_ie_test01-en". 
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8.3 Checklist – Exercise 

The following checklist helps trainees/students to independently check whether all steps of the 

exercise have been carefully completed and enables them to successfully complete the module 

on their own. 

No. Description Checked 

1 Simulation logic for a metal part added in the "03_part" chart. 
 

2 
"05_metal_sensor" chart created in SIMIT according to the 

specification. 

 

3 

Display for metal part, metal sensor and pushbutton for placing a 

metal part on the conveyor added in the "01_control_display" 

chart according to the specification. 

 

4 Simulation successfully tested within SIMIT. 
 

5 Simulation successfully tested together with SIMIT Simulation. 
 

6 SIMIT project successfully archived. 
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8.4 Task – Exercise Cylinder 

Create a new "06_Cylinder" chart with the simulation logic for the "M4" cylinder and the two 

sensors "-B1" (Sensor cylinder -M4 retracted / NO) and "-B2" (Sensor cylinder -M4 extended / 

NC). 

Draw a schematic drawing of the cylinder in the "01_control_display" chart and animate it. 

Also take into account how the part movement is influenced by the cylinder position. 

 

 

Figure 4: Control display with cylinder 
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8.5 Planning 

Plan the implementation of the task on your own.  

For testing you can load the following TIA Portal project in S7-PLCSIM Advanced: 

"020-120-sorting_station_plcsimadv_ie_test02-en" 

Example of a display of the cylinder in retracted and extended state: 

    

Figure 5: Control panel 

 

8.6 Checklist – Exercise 

The following checklist helps trainees/students to independently check whether all steps of the 

exercise have been carefully completed and enables them to successfully complete the module 

on their own. 

No. Description Checked 

1 
"06_cylinder" chart created in SIMIT according to the 

specification. 

 

2 
Display for the cylinder added in the "01_control_display" chart 

analogous to the specification. 

 

3 
Position of the cylinder taken into account in the simulation of the 

part movement. 

 

4 Simulation successfully tested within SIMIT. 
 

5 Simulation successfully tested together with SIMIT Simulation. 
 

6 SIMIT project successfully archived. 
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9 Additional information  

 

More information for further practice and consolidation is available as orientation, for example: 

Getting Started, videos, tutorials, apps, manuals, programming guidelines and trial software / 

firmware, under the following link: 

 

siemens.com/sce/s7-1200 

 

Preview „Additional information“  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.siemens.com/sce/s7-1200
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Further Information 

 

Siemens Automation Cooperates with Education 
siemens.com/sce 

SCE Learn-/Training Documents 

siemens.com/sce/documents 

SCE Trainer Packages 

siemens.com/sce/tp 

SCE Contact Partners  

siemens.com/sce/contact 

Digital Enterprise 

siemens.com/digital-enterprise 

Industrie 4.0  

siemens.com/future-of-manufacturing 

Totally Integrated Automation (TIA) 

siemens.com/tia 

TIA Portal 

siemens.com/tia-portal 

SIMATIC Controller 

siemens.com/controller 

SIMATIC Technical Documentation  

siemens.com/simatic-docu 

Industry Online Support 

support.industry.siemens.com 

Product catalogue and online ordering system Industry Mall  

mall.industry.siemens.com 
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